
Manuscript Preparation Kit 

This kit is to serve as a partner document to the Papers Template, and includes a 
summary of formatting instructions and all forms necessary to complete your 
manuscript and submit it for publication. Please read all information carefully, as 
several procedures have changed. 

I. Publication Instructions 
 

A. Publication Standards 
It is mandatory to follow the instructions given in Preparation of Papers for ICSSC 2005 (Papers_ 

Template.dot). This kit is presented in accordance with the new formatting standard. 
Your manuscript cannot be published if: 
1) It has been published previously or 
2) An appropriate copyright statement has not yet been selected. 
 

B. Paper Review and Visa Considerations 
It is the responsibility of the author to obtain any required government or company reviews for their papers in 

advance of publication. Start early to determine if the reviews are required; this process can take several weeks. 
If you plan to attend the Joint Conference  and you require a visa for travel, it is incumbent upon you to apply 

for a visa with the Italian embassy (consular division) or consulate with ample time for processing 
Prospective Joint Conference attendees requiring a visa to travel to Italy should first contact IIC  to request an 

official letter of invitation at info@iicgenova.it.  
For more information please visit the Italian Embassy Website at www.italyemb.org/visti.htm  

 
 

C. Tracking Number / Paper Number 
Your paper was assigned a password and a tracking number at the time you submitted your abstract. That 

password plus the corresponding author’s last name is used to access the Author Status Page. These numbers are 
also useful when contacting IIC technical support regarding submission difficulties. The tracking number is also the 
paper number once the abstract is accepted and assigned in the program.  The paper number appears in the format 
INNNNNN. Do not include the paper number anywhere on your paper, as this number will be added automatically 
in the file name of your paper at the time of processing. 

 
D. Copyright 

Before IIC can print or publish your paper, the copyright information on the web site must be completed and  
be faxed to:  

ICSSC 2005  
c/o Ed Elizondo 
fax No. +1-954-283-8580. 
Please be sure to indicate the paper number / tracking number on the form. 

Failure to complete the form correctly could result in your paper not being published. The following fields 
must be completed: 

1) Clearance Statement 
2) Non-Infringement Statement 
3) Publication Status Statement 
4) One Copyright Assignment Statement (From B, C or D - Form A is not recommended as it may conflict 

with the Copyright Assignment Addendum) 
5) Copyright Assignment Addendum 

Be sure to read the copyright statements carefully. If you are not sure which copyright statement to use, 
contact your legal department. 

Do not upload the copyright form with your paper. 
 



E. Submission Deadlines 
Manuscripts will be accepted for upload to the system from the receipt of the acceptance  e-mail letter to July 

30th. We ask that authors not upload a draft version of their manuscript with the intent to upload a final version later. 
Please upload only the final version of your manuscript! 

On-line conference proceedings will be made accessible to attendees who have registered for the "full 
conference" option two weeks prior the conference.  

To ensure conference quality, session chairs will enforce a "no paper, no podium" rule. This policy states that 
if your manuscript is not uploaded to the Web site prior July 30th, you will not be allowed to present the paper at the 
conference. 

 
F. Paper length and Color Illustrations 

Paper length for ICSSC-2005 is 12 pages, including images, figures and tables. The papers published 
electronically (online or on CD-ROMs) will be reproduced in color automatically. 

 
G. Text Based Abstracts 

For featuring in the Book of Abstracts, please use the following guidelines for submitting your abstract. into 
the “Text Based Abstracts” field on the Author Status Page : 

1. Cut and paste the abstract from your final manuscript into the text field on the Author Status Page. 
2. The abstract should not exceed 500 words in length. 
3. It should be a text-only abstract in paragraph form. 
4. Do not include the title or author information. 
5. Do not include graphics, figures, or mathematical equations. 
 

II. Submission of Your Manuscript   
 

All manuscripts are to be submitted electronically via the IIC Web site at http://www.iicgenova.it. To upload 
your paper, select “Abstract and Papers” on the home page and click on the chosen conference (ICSSC or KA and 
BCC), then click on “Submit a Paper ”. When you submitted your abstract for review, you should have received a 
password and a tracking number for your paper. Use the password, along with the last name of the corresponding 
author, to gain access to the  Author Status Page. This site will allow you to track your paper’s status and submission 
deadlines, update author information, select a copyright statement, and upload your final manuscript. 

Before you can upload your manuscript, you will need to select a copyright statement to appear on your 
paper. This can be achieved by clicking the “Copyright Information” link on the Author Status Page. Be sure to read 
the instructions and specific statements carefully before selecting a statement for your manuscript. 

Once you have selected a copyright statement, you can use the “Upload Paper” feature of the Author Status 
Page to upload your paper. The relevant submission deadlines appear directly on the Homepage of the conference 
Web Site Please pay special attention to these deadlines, as they are now strictly enforced. 

As with the submission of your abstract, be sure the name of the file you upload for processing is short and 
simple (i.e., “msc12345.doc”) with no spaces, tildes, symbols, or other unusual characters. If the file being uploaded 
is in Microsoft Word, the document must be based on the “Normal.dot” template (the Papers Template is based on 
this template). Failure to meet these requirements could result in a processing error that would require you to re-
upload your manuscript. If you run into difficulties with the upload and/or conversion of your manuscript, please 
contact IIC Papers Tech Support for additional assistance at studio@hyperdesign.it 

If you are uploading a PDF or postscript file, please do not include foreign (i.e., non-Roman alphabet) fonts.  
 

III. Formatting Guidelines 
 

The styles and formats for the Papers Template have been incorporated into the structure of this document. If 
you are using Microsoft Word 6.0 or later, please use this template to prepare your manuscript. If you are reading a 
hardcopy or PDF version of this document, please download the electronic template file, Papers_Template.dot from 
the Joint Conference website. Regardless of which program you use to prepare your manuscript, please use the 
formatting instructions contained in this document as a guide. 

If you are using this document to prepare your manuscript, you can simply type your own text over sections 
of this document, or cut and paste from another document and use the available markup styles. The pull-down menu 
on the left-hand side of the Formatting Toolbar at the top of your Word window contains all the styles you will need 



to format your document. Highlight a section that you want to designate with a certain style and select the 
appropriate style name from the pull-down style menu. The style will automatically adjust your fonts, tabs, and line 
spacing as appropriate. Do not change the font sizes, line spacing, or margins to squeeze more text into a limited 
number of pages. Use italics for emphasis; do not underline. Use the “Page Layout” feature from the “View” menu 
bar (View>Page Layout) to see the most accurate representation of how your final paper will appear. 

 
A. General Formatting 

The default font for ICSSC 2005 papers is Times New Roman, 10-point size. In the electronic template, use 
the “Text” style from the pull-down menu to format all primary text for your manuscript. The first line of every 
paragraph should be indented, and all lines should be single-spaced. Default margins are 1” (cm 2,54) on all sides. In 
the electronic version of this template, all margins and other formatting is preset. There should be no additional lines 
between paragraphs. 

Extended quotes, such as this example, are to be used when material being cited is longer than a few 
sentences, or the standard quotation format is not practical. In this Word template, the appropriate style is “Extended 
Quote” from the drop-down menu. Extended quotes are to be in Times New Roman, 9-point font and full justified. 

NOTE: If you are using the electronic template (Papers_Template.dot) to format your manuscript, the 
required spacing and formatting will be applied automatically, simply by using the appropriate style designation 
from the pull-down menu. 

 
B. Paper Number / Tracking Number 

Do not put your paper number / tracking number on the manuscript.  
 

C. Abstract 
The abstract should appear at the beginning of your paper. It should be one paragraph long (not an 

introduction) and complete in itself (no reference numbers). It should indicate subjects dealt with in the paper and 
state the objectives of the investigation. Newly observed facts and conclusions of the experiment or argument 
discussed in the paper must be stated in summary form; readers should not have to read the paper to understand the 
abstract. The abstract should be bold, indented 3 picas (1/2” – cm 1,27) on each side, and separated from the rest of 
the document by two blank lines. 

 
D. Headings 

The title of your paper should be typed in bold, 18-point type, with capital and lower-case letters, and 
centered at the top of the page. The names of the authors, business or academic affiliation, address, city,  
province/state, and country should follow on separate lines below the title. The names of authors with the same 
affiliation can be listed on the same line above their collective affiliation information. Author names are centered, 
and affiliations are centered and in italic type. The affiliation line for each author is to include that author’s city, 
address, province/state, and zip/postal code (or city, province/state, zip/postal code and country, as appropriate).  

Major headings (“Heading 1” in the template style list) are bold 11-point font, centered, and numbered with 
Roman numerals. 

Subheadings (“Heading 2” in the template style list) are bold, flush left, and numbered with capital letters. 
Sub-Subheadings (“Heading 3” in the template style list) are italic, flush left, and numbered (1. 2. 3. etc.) 
 

E. Footnotes and References 
Footnotes, where they appear, should be placed above the 1” (cm 2,54) margin at the bottom of the page. To 

insert footnotes into the template, use the Insert>Footnote feature from the main menu as necessary. Footnotes are 
formatted automatically in the template, but if another medium is used, should appear in superscript as symbols in 
the sequence, *, †, ‡, §, ¶, #, **. ††, ‡‡, §§, etc. 

List and number all bibliographical references at the end of the paper. Corresponding superscript numbers are 
used to cite references in the text,1 unless the citation is an integral part of the sentence (e.g., “It is shown in Ref. 2 
that…”) or follows a mathematical expression: “A2 + B = C (Ref. 3).” For multiple citations, separate reference 
numbers with commas,4,5 or use a dash to show a range.6-8 Reference citations in the text should be in numerical 
order. 



 
F. Images, Figures, and Tables 

All artwork, captions, figures, graphs, and tables will be reproduced exactly as submitted. Be sure to position 
any figures, tables, graphs, or pictures as you want them printed. IIC will not be responsible for incorporating your 
figures, tables, etc. (Company logos and identification numbers are not permitted on your illustrations.) 

 
G. Equations, Numbers, Symbols, and Abbreviations 

Equations are centered and numbered consecutively, with equation numbers in parentheses flush right. Use 
only standard symbols and abbreviations in text and illustrations. Be sure that the symbols in your equation are 
defined before the equation appears, or immediately following. 

 
H. Page Numbers and Identifications 

The page number should be printed on the bottom center of every page. 
 


